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1 Introduction & Overview of the Diva Interface 

This chapter describes the system, terms and concepts of integrating System Galaxy (SG) with the 
DIVA Networked Video Recorders (NVR) & Video Management Software (VMS).  

1.1 INTRODUCTION TO DIVA - Networked Digital Video Recording System 
DIVA (Digital Intelligent Video Architecture) is a PC‐based, networked digital video recording 
system that offers advanced features such as face and license plate recognition.  

 Diva uses networked client‐server architecture over LAN/WAN via TCP/IP protocol.

 Diva supports IP‐based cameras and uses a PostgreSQL Database, an open‐source RDBMS.

The DIVA Video Management Software (VMS v2.1.6) is the DIVA software that installs/runs on the 
Diva servers and clients.  Using the DIVA SDK version 2.5.1 

 One Diva server is designated to function as the main server, i.e. “Management Server”.
The remaining video recorders are configured use the main server’s IP address.

 The Management Server takes video requests from SG clients and streams live video from
the chosen camera to the appropriate Diva Client (monitor, layout, and panel).

 DIVA Client uses multi‐panel layouts (such as 2x2 or 2x3, 3x3, etc.) on their monitors. One
panel of the layout can be dedicated to displaying video for System Galaxy clients.

The interface with System Galaxy allows SG Clients to request live video from the Management 
Server, which will be streamed to a designated Diva Client (monitor, layout and panel). 

FIGURE 1 – Concept: Diva Server Managing Video via Galaxy Request 
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1.2 ABOUT SYSTEM GALAXY VIDEO SOLUTION WITH DIVA 

The System Galaxy video solution with Diva always uses the Diva Client monitor to display all 
requested video from System Galaxy.  

The Galaxy client will request live video from the Diva Management Server. The Diva Server will 
stream live video to the appropriate Diva Client monitor based on the ‘Diva Client ID’s stored in the 
Galaxy client registry.  

Video is requested by Galaxy under two conditions.  

 when the SG operator manually commands video to start for a specific camera.

 when a door or alarm input automatically triggers video to start for a camera that is linked
to the door or input based on SG software configuration.

.  SG operator‐requested video or alarm‐triggered video will always display on the same monitor in 
the same designated layout & panel, regardless of which camera is selected.   

The Diva Client software and monitor can be on the same workstation as the Galaxy client 
software, or they can be on separate clients – as you can see depicted in the drawing below. 

FIGURE 2 – CONCEPT: SG Operator Viewing Video with Diva 
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1.3 LIST OF SUPPORTED DVR FEATURES  
   Add/use multiple DVRs, site‐wide (Corporate and Enterprise product levels) 

   Import pre‐configured Camera Names from DVR   

NEW   Video Viewing and PTZ and preset controls provided through the DIVA client software  
   [Note: Diva client software must be installed on the SG client workstation.]  

NEW   Supports Galaxy‐designated DIVA video panel  (one panel on the DIVA Layout is reserved for 
SG Operator video calls to any configured camera).   

 

 Supports Live Video from alarm‐triggered* or operator‐triggered requests via camera linking 
to inputs or readers (based on SG configuration).  

* Alarm‐triggered video requires ‘Automatic Call‐up on alarm condition’ to be enabled. 

   SG Operator able to request live video from within SG – from incoming alarm events and 
hardware‐tree commands within System Galaxy software. 

 TIME SYNCHRONIZATION:  System Galaxy is Network Time Synchronization (NTS) compliant.  NTS must be 

supported by the DVR also.  You must refer to the DVR manufacturer’s instructions to determine whether 
their DVR can reside on a domain and how to use time synchronization.  See the appendix for tips on 
setting up time‐synchronization. 

 

1.3.1 TERMS AND DEFINITIONS 

DIVA Digital Intelligent Video Architecture ( the Diva acronym is trademarked) 

Alarm-Triggered 
Video Request 

Is an automatic call‐up of live video that is triggered by an armed alarm condition in 
System Galaxy for a door or input that is linked to a camera?  Live video from the linked 
camera is streamed to the dedicated* panel at the designated* Diva Client.  

Diva Client IDs 
The numeric values of the target Diva Client (workstation ID, Monitor #, Layout ID & 
Panel #) that a Galaxy client will use or transmit when requesting video.  

Diva Client Refers to the PC that is running the Diva Client Software or the software itself. 

Galaxy Client The PC that runs the System Galaxy software or the software itself. 

Management 
Server 

One of the recording servers must be designated to be a management server. The 
management server handles the video requests for the Galaxy Client 

Recording 
Server(s) 

The DIVA servers that the cameras are attached to. 

Target Diva Client The Diva Client that is chosen to display video for Galaxy when operator requests it. 

Dedicated or 
Designated  

A Diva Client or one of it’s video panels can be designated to the purpose of playing 
live video requests from a System Galaxy client.  
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2 Requirements & Dependencies 
 

This section lists the known requirements to integrate Galaxy with the DIVA System. These 
requirements are divided into sections as they apply to the server or client. Requirements are listed in 
order of their dependency.  If you find that something isn’t working as expected, then review the 
requirements in sequence beginning with section 2.1 until you discover the . 

 
 

2.1 DIVA MANAGEMENT SERVER DEPENDENCIES 

Fulfill these dependencies at the DIVA Servers before adding DVRs and cameras to System Galaxy 
software programming. 

1) At least one of the Diva recording servers must be designated as the “management server” – 
this is the unit that will be added to System Galaxy.   

NOTE: You must know the IP parameters (IP address & port #) and login credentials of the 
Diva Management Server for adding the server as a DVR to the System Galaxy software.   

2) The DIVA recording servers must be configured with the IP address of the management server 
and properly licensed for the number of camera channels needed. 

3) Client Layouts cannot be shared between Diva clients. You must create a unique, individual 
video layout for each DIVA client using the Diva software. This must be done before you can 
run the Diva Interrogator Utility at the Galaxy clients.  

TIP: Give layouts a descriptive name to make it easy to determine which layout goes with which 
Diva client.  

4) SHORTCUT: If you wish to import camera names from the Diva Server into System Galaxy, you 
must first configure the descriptive camera names at the DIVA Server(s).  

Note: You can always manually edit camera names in Galaxy if you did not do so at the server 
before importing. However, by naming cameras at the DVR server, you ensure the names are 
correctly and match in both places and avoid having to manually program camera names twice. 

5) NOTICE: The Diva Management Server and target Diva Client must be running and logged‐in 
to support System Galaxy requesting video.  The Recording Servers and cameras must be 
online also. 

 
 

 

SEE: the Diva Manufacturer’s Documentation for instructions on how to install and 
configure the DVR Servers, cameras, or Client workstations associated with DIVA.  
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2.2 DIVA CLIENT PREREQUISITES & DEPENDENCIES 

Fulfill these dependencies at the DIVA Clients before running the Diva Interrogator Utility and before 
System Galaxy video viewing can begin operation.  
 

1) DIVA client software can be installed on the same PC or a separate PC as the System Galaxy 
client software.   

a. If Diva and SG are installed on the same PC, you must have two monitors. One must be 
dedicated to the DIVA client software and the other monitor must be dedicated to SG.   

b. If they are on separate PC’s you only need one monitor for each client. 

2) Galaxy‐requested Live video will always display in the designated panel # of the DIVA monitor. 
This is based on preconfigured registry settings that are saved at the local workstation of the 
Galaxy client. These settings are captured and written to the Galaxy workstation using the Diva 
Interrogator Utility. See the Galaxy client requirements for more about the Diva Interrogator.   

3) A unique DIVA Layout must be created at the Diva Server and be available to the DIVA client.  
This is a prerequisite for the Interrogator Utility and the System Galaxy client.   

Note: a layout is available when it is not being used at a different client. Layouts cannot be 
reused/shared between Diva clients. The layout can be already running or just available to call 
up.  When video is requested by Galaxy, the layout and panel # are included and the layout and 
video should start up at the Diva monitor provided that the VMS software is running.    

4) DIVA client software must be logged‐in and running in order to play the requested video. 

 
  

 

SEE: the Diva Manufacturer’s Documentation for instructions on how to install and 
configure the DVR, cameras, or any client-side components associated with the DVR.  
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2.3 SYSTEM GALAXY CLIENT REQUIREMENTS 
These requirements are listed in dependent order. The Diva requirements in sections 2.1 and 2.2 must 
be completed before you can add a DVR, import cameras and set the Diva client IDs. 

1) System Galaxy must be registered for ‘DVR Support’ (i.e. DVR option must be checked/ON 
and the number of DVR units must be set in the ‘System Registration’ screen) per the 
purchase agreement or maintenance upgrade.  Registration is done at the System Galaxy 
communication server for customers using Corporate or Enterprise product levels.  Registration 
is performed by the Installer/Dealer through the Galaxy Customer Service or the Dealer’s Online 
Registration service (secure dealer login is required).  

2) Each Galaxy Client* must have its System Settings configured in the SG Software: 
a. the DVR Enabled checkbox must be “checked” on the General Options tab of the SG 

System Settings screen. 
b. the Automatically Call‐up Video option must be “checked” on the Alarm Options tab of 

the SG System Settings screen. 

3) You must add the IP address, port and log‐in credentials of the Diva Management Server(s) to 
the System Galaxy programming – this is done in the DVR Programming screen. There must be 
at least one Management Server – regardless of how many recorders there are. The recorders 
are not added to Galaxy. 

4) It is possible to import the Camera Names into SG – in order to do this, the camera names must 
have already been created at the DVR server before they are imported in SG. It is possible to 
change the camera names in SG after adding them, but it may cause confusion if they don’t 
match the DVR’s list of names.  It is best practice to make the camera names at the server and 
import them once into SG. 

5) For alarm‐triggered video, cameras must be linked to doors & inputs in order for ‘armed 
alarms’ to automatically call‐up video at the designated DVR panel. This is done in the reader 
or input properties screen.  Alarm‐triggered video should automatically start the correct layout 
as long as the Diva client software is running.  Steps 1 thru 4 must be completed first. 

6) The Diva Client IDs must be saved in the local registry of each Galaxy client PC* that supports 
operator‐requested or alarm‐triggered video.  This is accomplished by running the Galaxy’s 
DIVA Interrogator Utility at the local client. This is done at the Galaxy client whether it is on a 
separate or same PC as the Diva Client. (see next section for details on the Utility dependencies) 

* The PC registry settings and client software settings do not have to be enabled at an SG 
Client that is not designated to monitor alarms and video. 

7) OPERATION: To view video at a Diva Client, the Diva servers, clients and cameras must all be 
online/running.  The Management Server and target client must be logged‐in.  The necessary 
layout must have been created and available.  And the Diva Client IDs must be saved to the SG 
client PC registry.  System Galaxy client software must be running at the local PC also. 
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2.4 DIVA DVR INTERROGATOR UTILITY REQUIREMENTS 

The SG operator’s ability to direct the video to the correct workstation, monitor, and video panel is 
dependent upon having the DIVA component IDs saved in the local workstation registry.  Setting the 
client registry values is performed by Galaxy’s DIVA Interrogator Utility. 

 

1) You must copy the Interrogator executable files (.exe and .dll) to the local Galaxy workstation 
so you can run the utility against the local registry. The Diva Interrogator Utility will be 
provided to the installer on a discrete CD.   

2) You must run the Diva Interrogator Utility on any Galaxy client that supports ‘requested 
video’.  The utility will save the DIVA Client IDs to the local registry of the Galaxy client.   

3) You must enter the IP address and log‐in credentials of the Diva Management server in order 
to connect and retrieve the list of Diva Client IDs. 

BEST PRACTICE: Stop all DIVA clients except the desired target DIVA client that you are 
retrieving the IDs from. The Interrogator Utility will pull back all clients that the Diva server 
thinks are online. This way you will not accidentally chose the wrong client or monitor.   

IMPORTANT: you must know the Monitor # of the Diva Client if the Diva client is installed on a 
shared workstation (a shared workstation has 2 monitors).  To find the monitor #, sign into the 
Diva client software and look to the top of the Diva window. 

4) In order to connect, retrieve and save the Diva Client IDs to the Galaxy workstation … 

a. The DIVA Management Server must be running and signed‐in  
b. the target DIVA client software must be running and signed‐in and  
c. the correct Diva layout must be created and available to run on the Diva client (meaning 

it is already selected and running at the Diva client or is available to be called‐up (it 
cannot be in‐use by a different client). 

5) See the instructions in this guide for more in‐depth instructions. 
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3  About Configuring the Diva System   
 
This chapter briefly outlines the known Diva configuration that  System Galaxy depends upon.   
 
 

 
 QUICK STEPS: SETTING UP THE DVR INTERFACE  

3.1) Installation of the Diva servers and clients 

3.2) Designating a Management Server 

3.3) Configuring the Camera Names 

3.4) Configuring the client layouts 
  
 
  
 
 
 
 
 

 

SEE: the brand Manufacturer’s DVR Documentation for instructions on how to install and configure 
the DVR and camera hardware or client-side components associated with branded DVRs.  

 
 
 

 

SEE: the System Galaxy Software Installation Help  for instructions on how to install System Galaxy 
software.  These installation instructions are found on the HELP module on the CD 1 menu.   

 
‐
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3.1 SYSTEM OVERVIEW 

The Diva system consists of a Diva Management Server, Recording Servers and Diva Clients.  One of the 
recording servers will be designated as the management server.   

System Galaxy clients will request video for a specific camera (from the management server) which will 
be called‐up from the appropriate recording server and streamed to the designated Diva Client 
monitor.   

System Galaxy knows which Diva Client (monitor/layout/panel) to designate for video once the Diva 
Client IDs have been saved in the Galaxy client PC registry. 

 
FIGURE 3 – OVERVIEW OF SYSTEM INSTALLATION  
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3.2 DESIGNATING A MAIN MANAGEMENT SERVER 
 
1) At least one Diva recording server must be designated as the “Management Server”.   

 It is possible to have more than one management server.   

 The management server will be added to the System Galaxy software as the DVR Unit.   

FIGURE 4 – CONCEPT: Management Server  

 

 

2) The Management Server IP address, port and log‐in credentials must be added to System Galaxy.  

 make sure you know the IP address and Login credentials  

 or have someone with clearance on‐hand who knows these credentials. 

Tip: The installer can use DIVA’s default log‐in and password to perform the initial configuration of Diva 
servers/clients and programming into System Galaxy.   

IMPORTANT: If the System Owner changes log‐in Credentials at the Management Server, the 
credentials must be changed in System Galaxy also. 
   
3)   The Diva Recording Servers must be configured with the IP address of the “Management Server” 

via the VMS software.  

 The management server will call‐up live video from the appropriate recording server & camera. 
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3.3 ABOUT CONFIGURING CAMERA NAMES 

Camera channels must be licensed at the Diva Recording Servers and named appropriately. 

1. The camera names should be pre‐configured in the Diva System before importing the names 
into the System Galaxy software. 

2. Camera names can be imported after the Management Server is added to SG.   

3. If you pre‐configure the camera names in the Diva System, you can avoid duplicate work of 
having to configure matching camera names in both systems.  You also reduce the risk of 
mistakes.  

1. TIP: Use descriptive naming scheme that identify the video channel number at the 
recorder and includes a identifies the location or direction of a camera. For example,  
“Front/Parking Cam 01”, “Roof/West Cam 02”, or “Tech Hall”.  

2. Descriptive naming helps technicians trace down equipment problems and helps 
security operators quickly identify and respond to trouble areas.   

4. If you do not pre‐configure the camera names in the Diva System, you can still configure and 
name the cameras within System Galaxy. See the section on adding cameras to SG.  
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3.4 DIVA CLIENT INSTALLATION OPTIONS  

There are two options when configuring the DIVA Client monitoring: 

OPTION‐1  SEPARATE WORKSTATIONS: The Diva Client software can be installed on a separate 
PC from the Galaxy client.  The Galaxy client will be configured with the target Diva Client IDs.  

Theoretically, multiple Galaxy clients can be pointed to a Diva Client workstation. In such a case, 
you must decide if the Galaxy clients will all point to the same viewing panel or different 
viewing panels.   

IMPORTANT: If more than one Galaxy client is pointed to the same Diva viewing panel, then the 
last one to request video will be the camera that is displayed.   

OPTION‐2  SHARED WORKSTATIONS: Diva Client software can be installed on the same PC as 
the Galaxy client. The Galaxy client will be configured with the Diva Client IDs. System Galaxy 
client and the Diva Client must both have a dedicated monitor on this shared workstation. 

 

3.5 CONFIGURING DIVA CLIENT LAYOUTS  

You must create unique and separate layouts for each Diva Client.  Layouts cannot be shared.  From a 
Galaxy perspective, the layout must be available when a Galaxy client requests video.  “Available” 
means it has been created and is either already running at the target Diva monitor or is free to run (i.e. 
not in use by another client/monitor). 

NOTE: A layout determines how many video panels (# of cameras) that will be displayed at once.  There are 

typically 2x2 (4), 2x3 (6), or 3x3 (9) panels in the layout.  One panel will be reserved for Galaxy requests. 

IMPORTANT: The Layout ID is one of the required DIVA Client IDs that must be set in the Galaxy Client’s 
local registry.  The layout ID is assigned by Diva when the layout is created.  See the section in this guide 
about Setting the Diva Client IDs using the Interrogator Utility. 

Use the table here to help map which Diva Client, monitor, layout, panel (Diva client IDs) you want to 
designate for streaming Galaxy Client‐requested video.    

Galaxy Client PC 
Local workstation 

Target Diva Client 
Workstation ID  Diva Monitor ID  Layout ID  Panel ID 
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4 Setting ‘Diva Client IDs’ at each Galaxy Client PC  
  

4.1 ASSIGNING ‘DIVA CLIENT IDs’ to GALAXY REGISTRY 

When System Galaxy sends a video request for a specific camera to the Diva Management Server, the 
message must include the Diva Client ID’s for the desired (target) Diva Client.  The Diva Management 
Server uses those ‘Diva Client IDs’ to determine where to stream video.  

The Diva Interrogator Utility is used to retrieve the Diva Client ID’s  and record/save them into the local 
PC registry at Galaxy Client.  You must install and run the Interrogator on every Galaxy client – see the 
section pertaining to the Interrogator for details. 

Once the Diva Client ID values are set in the local Galaxy client registry, all video requested by System 
Galaxy will always display at the same Diva Client, using the same Layout and Panel.   
 

The “Diva Client ID” values are … 

 Workstation ID (this is the machine number of the target Diva Client PC) 

 Monitor ID (this is the monitor that will display the Diva Client software ‐ the monitor 
number is shown at the top of the Diva client software) 

 Layout ID (this ID is assigned by Diva at time the Layout Name is created; the Interrogator 
Utility will show the Layout ID when you pick the Layout Name in its droplist. ) 

 Panel ID (the possible values will display in the Interrogator droplist when you choose your 
Layout; which Panel is chosen will be at the discretion of the system programmer) 

FIGURE 5 – CONCEPT: Assigning Diva Client IDs to Galaxy Client 
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4.2 RUNNING THE DIVA INTERROGATOR UTILITY 

The Diva Interrogator Utility must be installed and executed at any Galaxy client that requests video.  

You must copy the Diva Interrogator Utility files (.exe and .dll) to the local Galaxy Client PC that will be 
issuing requests for video.  Any Galaxy clients that are restricted from requesting video will not need to 
set the Diva Client values into its registry. 
  
 

4.2.1 INSTALLING THE DIVA INTERROGATOR UTILITY 

 
1) Copy the Diva Interrogator Utility files to the local Galaxy Client PC that will issue requests for video.   

 DivaInterrogator.exe 

 GCS_DIVAHttp.dll 
 
FIGURE 6 – INSTALLING DIVA INTERROGATOR UTILITY  
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4.2.2 TESTING AND SAVING THE ‘DIVA CLIENT IDs’ 

The Interrogator Utility must use the correct IP address and log‐in credentials of the Diva Management 
server in order to solicit the server for the lists of Diva Client component values. 
 
PREREQUISITES: 

 All Diva Servers must be running and cameras must be online in order to fulfill testing of settings. 

 You must be fully logged into the Management Server.   

 You must have already created the Layout you will be choosing. 

 The target Diva Client must be running and you must be logged into the Diva Client software.   

1. Enter the DIVA address and log‐in credentials of the Management Server 

2. Click CONNECT to connect to the Management Server 

3. Once you connect, the Diva Servers and Cameras droplists will be populated. If the 
Cameras are PTZ types, the presets will also populate.   

Note: The camera’s and presets are not saved to the PC registry. They are available for 
the purpose of testing the video streaming. 

 
FIGURE 7 – CONNECTING TO THE MANAGEMENT SERVER  
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4. Select the desired DIVA Recording Server and Camera in order to test your settings in a 
later step.  

5. Choose the DIVA Client workstation to be designated for Galaxy video. NOTE: the target 
Diva Client & Diva software must be running and signed‐in. 

6. Choose the monitor number (this is found/displayed at the top of the Diva Client screen) 

7. Choose the desired layout (must be created and available) 

8. Choose the desired panel (at the preference of the system programmer/owner) 

9. Click TEST SHOW VIDEO if you want to confirm that your choices give the desired results 
(the target Diva client must be online and logged‐in) 

10. Click the USE SELECTED VALUES in order to write the selected values to the local PC 
registry (System Galaxy will always use these Diva Client IDs when requesting video until 
you change them). 

11. Restart the System Galaxy software to reinitialize with new settings. 
 
FIGURE 8 – SELECTING THE DIVA CLIENT IDs  
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5 Configuring System Galaxy for DVR Support 

This chapter describes the registration and configuration in System Galaxy.   
 
 
 

 
 QUICK STEPS:  SETTING UP THE DVR INTERFACE  

 

4.1) Registering the SG System for the DVR 

4.2) Enabling DVR Support in System Settings 

4.3) Adding a DVR (the Diva Management Server) in System Galaxy 

4.4) Importing the Camera Names into System Galaxy 

4.5) Linking Cameras to hardware devices in System Galaxy 
  
 
After the initial system programming is completed, the SG Operator can begin using the DVR features.   
 
 
 
 
 

 

SEE: the brand Manufacturer’s DVR Documentation for instructions on how to install and configure 
the DVR and camera hardware or client-side components associated with branded DVRs.  

 
 

 

SEE: the System Galaxy Software Installation Help  for instructions on how to install System Galaxy 
software.  These installation instructions are found on the HELP module on the CD 1 menu.   
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5.1 Registering System Galaxy for DVR Support 
 

DVR Support is registered during the initial System Registration for a new install.  

DVR Support can also be added to an existing system by upgrading.  

A new registration code must be acquired from Galaxy Control Systems when adding DVR support 
through an upgrade (Certified Dealer required). 

1) Open the System Registration screen – Configure > Options > Registration > System. 

 In the System-Wide Features, you will check the DVR option to enable it.   
 Check the “DVR Support” option  
 and select the number of units needed. 

 Complete the normal registration process as needed  

 Enter a valid Registration Code (if you are upgrading, this code will be changed) 

 Click [Apply]  and   [OK] buttons 

2) Complete the Workstation Registration as required for new installs. 

3) Restart System Galaxy software after registration is complete. (If you are changing the workstation 
options, you can restart software after completing that – see next step) 

FIGURE 9 - PRODUCT REGISTRATION SCREEN – DVR SUPPORT OPTION 

 

Enterprise level supports Diva DVR options.   
 DVR Support must be checked for DIVA brand 
 Set the number of DVR units 

Corporate level supports Diva DVR options.   
 DVR Support must be checked for DIVA brand 
 Set the number of DVR units 

 

 

SUPPORT: Dealers may use GCS Online Registration website 24/7 (dealer online logon is 
required), or call customer service.A valid maintenance agreement is required for upgrading systems. 
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5.2 Enabling/Disabling DVR Support per Galaxy Workstation 

You can enable or disable the DVR Interface at each Galaxy workstation individually through the 
System Settings screen. You may not want every workstation in your system to be able to request 
video. This option is ON/enabled by default when you install the client software.  

 

1) Open the System Settings screen - from menu Configure > Options > System Settings 

2) Select the General Options tab 

3) “check” the DVR Enabled option to enable it. (If “unchecked”, you will not be able to see the DVR 
Types droplist in the DVR programming screen.) 

4) Click the APPLY button and OK button to save your changes. 

5) Restart the System Galaxy software to initiate the changes. (NOTE: see next step before restarting) 

 
FIGURE 10 – ENABLE DVR SUPPORT IN SYSTEM SETTINGS SCREEN 
 

 

DVR Enabled option in the General tab 
 checked = enables the DVR connections  
 unchecked = disables the DVR connections 
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5.3 Setting Auto DVR call-up for Armed Alarms (per Workstation) 

You can configure the workstation to automatically show INSTANT LIVE FEED when an armed alarm 
occurs in the System Galaxy system. This is enabled by checking the ‘Automatically Call-up DVR 
Video’ option in System Settings screen. 
 

IMPORTANT:  

 This is a per workstation setting, and will not affect other workstations in the Galaxy system. 
 A master operator login is required to edit System Settings (or System Settings) screen. 
 The ‘Automatically Call-up DVR Video’ shows video for cameras that are linked to an input or 

door/reader that has been configured to need acknowledgement and that are armed. 
 Alarm Priority: Be aware that if you if you are using alarm priorities, that the live feed will 

come from the camera with the highest priority.  
 

1) Open the System Settings screen - from menu Configure > Options > System Settings 

2) In the Alarm Options tab, you will check the ‘Automatically Call-up DVR Video’ option to enable it.  
Unchecked means the option is disabled and the DVR Viewer will not Auto-call LIVE feed for any 
armed alarms.  

3) Click the APPLY button and OK button to save your changes. 

4) Restart the System Galaxy software to initiate the changes. 
 
 
FIGURE 11 – ENABLE DVR SUPPORT IN SYSTEM SETTINGS SCREEN 
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5.4 Adding a DVR (the Diva Management Server) 

The following steps describe adding a DVR Unit to the System Galaxy software and configuring the 
connection settings. 

1) Open the DVR Programming Screen from menu, Configure > Hardware > DVR’s   

2) Click the [Add] button in the DVR screen to add a DVR.  
3) Enter a unique name for the DVR in the [Name] field (i.e. “DVR Unit 01”).  This name will appear 

in [DVR droplists] in the Camera Programming screen and in the Reader/Input Programming 

screens.  
4) Choose a DVR type from the [Type] droplist that matches the type of DVR you will connect to.   
5) Enter the IP address or DNS Name of the DVR Unit. 
6) Enter IP Port Number if it will be different from the default value automatically shown. 
7) Enter the User Name & Password (logon): The login used here must exist at the DVR Unit and 

does not necessarily need to be the highest logon, but must allow viewing and controlling video.   
8) Click the [Apply] button to save settings.  
9) Restart System Galaxy software.   

 
 

 
Use the [edit] and [delete] buttons to edit or delete an existing DVR Unit’s configuration. 

 
 
FIGURE 12 – DVR PROGRAMMING SCREEN  
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5.5 Importing or Renaming Cameras in System Galaxy 

This section describes importing or renaming Cameras in System Galaxy.  System Galaxy auto-fills the 
DVR’s camera droplist with 16 cameras when you add the DVR.   

NOTES 
 

 
CAMERA MAPPING:  the Camera NUMBER/ID in System Galaxy maps to the camera channel number 
at the DVR Recorder. The names can be imported. 

 
CAMERA NAMING:  When manually naming cameras … 

 Use logical names to identify the camera’s physical location, such as “lobby”, “guard desk”, 
“dock‐5”, “break room”, “east gate”, etc.    

 
UPDATING THE HARDWARE TREE’s CAMERA LIST:  Close and reopen the Hardware Tree to refresh 
the Camera list if needed. From the menu select View > Hardware Tree to reopen it. 

 

5.5.1 IMPORTING CAMERA NAMES FROM THE HARDWARE TREE 

1. right‐click the DVR Icon in the Hardware Tree  

2. selecting the Menu Option to ‘Import Cameras’ (refresh Hardware Tree by reopening it from View menu) 

 

5.5.2 RENAMING CAMERAS FROM THE CAMERA PROGRAMMING SCREEN 
 

1) Open the Camera Programming Screen from menu, Configure > Hardware > DVR Cameras   

2) Click the [Edit] button in the Camera screen to rename a Camera.  

3) Select a DVR name from the [Select DVR] droplist that you wish to configure the cameras for.   

4) Type a unique name for the Camera in the [Name] field (i.e. “Lobby 01”).  This name will appear in [Camera 

droplists] in the Reader/Input Programming screens.  

5) Click the [Apply] button to save settings. Camera Name will appear in the HARDWARE TREE. Refresh the 

hardware tree by re‐opening it from the View menu. 

 
FIGURE 13 – CAMERA PROGRAMMING SCREEN  
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5.6 Linking Cameras to Hardware in System Galaxy 

Cameras can be linked with a Door Reader, Elevator Reader or Input Device.   
 

5.6.1 LINKING A CAMERA TO A READER 

1) Open the Reader Programming Screen from menu, Configure > Hardware > Door/Reader  

2) Select the Loop, Control Panel, and Reader you want to link to a camera. 

3) Select the ‘DVR Camera Settings’ tab and click [Edit] button 

4) Click EDIT to configure the CAMERA link 

 Select the DVR then Camera you want to link to. 

 If the chosen camera is a PTZ and your DVR supports client-side presets (such as 

Discovery-3) 

5) (optional) To cause this device to trigger an alarm condition within System Galaxy, set 
the    Ack option to “checked”. This option is in the Alarm Options tab.  NOTE: see the 
section on Auto Calling Video on Alarm to configure automatic start up GCS DVR Viewer 
and live video feed plays back.  The highest priority alarm will be displayed. 

6) Click [Apply] button to save changes. 
 
 
 

NOTES 
 

  LINKING MULTIPLE READERS TO A CAMERA:  You can link more than one reader with a camera.    

 
UNLINKING READERS FROM A CAMERA:  You can UN‐link a reader from a camera by setting the DVR 
field to “NONE”.    

 

FIGURE 14 – LINK CAMERA TO A DOOR/READER - PROGRAMMING SCREEN  
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5.6.2 LINKING A CAMERA TO AN INPUT 

 

1) Open the Input Properties screen from menu select Configure >Hardware >Input Devices 

2) Choose the desired Loop, Control Unit and Input Name from drop lists as necessary. 

3) Select the ‘DVR Camera Settings’ tab and click [Edit] button. 

4) Select the desired DVR and Camera from the drop lists. 

5) Set the  Show in Tree option to “checked” to allow the input’s camera option to be selectable 
from the short-menu in the SG Hardware Tree.   

6) Set the  Acknowledge option to “checked” to allow the input to trigger an alarm if desired.  
NOTE: that an alarm condition can be used to automatically start up GCS DVR Viewer and live 
video feed. 

7) Click [Apply] button to save changes, then refresh Hardware Tree (close and re-open) to 
display the input icon in the tree.  Hardware Tree can be reopened from the View Menu. 

 

NOTES 
 

  LINKING MULTIPLE INPUTS TO A CAMERA:  You can link more than one Input with a Camera.    

 
UNLINKING READERS FROM A CAMERA:  You can UN‐link a reader from a camera by setting the DVR 
field to “NONE”.    

 
 
 
 
 

FIGURE 15 – LINK CAMERA TO AN INPUT - PROGRAMMING SCREEN  
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5.6.3 VALIDATING CAMERA MAPPING IN SG 

Once the configuration is complete, test the input / reader devices to prove they are correctly mapped 
to the corresponding camera and that you can connect to each camera / display video for the area you 
expect.   

Follow the numbered steps to test each device.  (The table below assists your verification).   

1. Select the Event Monitoring Screen ( System Galaxy is running and connected to loops) 
2. Open the Hardware Tree and expand the objects to see all inputs and readers.  
3. Induce an event for the device from hardware tree icon (i.e. right-click the icon and pulse / 

shunt).   
4. Select the resulting event on the Event screen and right-mouse-click to pick the ‘View Live 

Video’ option from the short-menu.  See Figure-8 in Chapter 3 for an example. 
5. Verify the DVR Viewer opens/displays video for correct area.   
6. Unshunt any input after verification is complete. (inputs only) 
7. Repeat steps 3 through 6 for each device in the list.   

Camera Connections Validation List (extra copy in the back – see Appendix A) 

DVR NAME:    DVR LOCATION:  

Device Name/type  Camera #  Camera Name  Location/Area Displayed  Check

  1    
  2    
  3    
  4    
  5    
  6    
  7    
  8    
  9    
  10    
  11    
  12    
  13    
  14    
  15    
  16    
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6 Operating the DVR Viewer in SG   

This chapter covers the operator‐requested and alarm‐triggered methods of streaming video to Diva 
Clients. 

6.1 Methods of Requesting Live Video  
You can retrieve (or ‘call up’) video manually or automatically in System Galaxy. 

6.1.1 AUTOMATIC VIDEO CALL‐UP (ALARM TRIGGERED) 

  (Automatic call-up / instant Live Feed) an armed alarm is generated from an input or door that is 
linked to a camera (provided the workstation auto call-up option is ON and that device’s ACK option is 
ON) 

6.1.2 MANUAL VIDEO CALL‐UP (OPERATOR REQUESTED) 

  (Live Feed) Operator calls video from the icon of a camera-linked device (reader/input) 

 

The example below shows operator calling video for a door/reader that is linked to a camera.   

1. right-click the door icon in the Hardware Tree to open the command-menu 

2. choose the View Live Video option to open/start playing live feed for that camera in the GCS DVR 
Viewer.  

 
FIGURE 16 OPERATOR-REQUESTED VIDEO: Call-up live video for a linked camera  
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6.2 Runtime Modes for Diva’s Client Viewer  
There are two runtime modes for the DVR Viewer; Normal/Integrated Mode and Standalone Mode. 
 

6.2.1 NORMAL INTEGRATED MODE 

The Diva Client streams Live video in the designated layout/panel when video is requested by System 
Galaxy. Video is called by either manual operator-requested or alarm-triggered.   

NOTES:  

 The ‘View Live Video’ option only displays on command menus from the device icons or 
event messages provided the device is linked to a camera.   

 Manual and automatic calling video is covered in the previous section of this chapter.    
 See chapter 4 for instructions on linking cameras.     

 
 
 
 

6.2.2 DIAGNOSTIC MODE ( Using the Diva Interrogator Utility ) 

The Interrogator can SHOW VIDEO based on filtered selections (workstation, monitor, layout and panel.  
This can be done for trouble shooting purposes. You must supply the IP connection parameters and log-
in credentials to the Diva Management Server.    
 
 
 

6.2.3 BLOCKING VIDEO AT A WORKSTATION 
 
 
 
 

 

Blocking Video per Workstation:  The GCS DVR Viewer can be disabled on a per 
workstation basis.  See Chapter 2 in this manual for info on enabling/disabling the 
Viewer at individual workstations. 
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6.3 Viewing Modes of the DVR Viewer  

The DVR Viewer has two viewing modes, LIVE and RECORDED.     
 

 WHERE VIDEO CALLS FROM… DIVA PANEL 

Automatic call up  from an incoming armed alarm YES 

Operator Commanded 

from SG Hardware Tree  
 a device icon  
 a camera icon  
 an incoming event 

from SG Graphic Floor plan  
 an icon on a floor plan 

YES 

Operator Selected from DIVA Client -  LIVE 
 a chosen camera (droplist) 

YES 

Operator Selected 

from DIVA -  RECORDED 
 a chosen camera (droplist) 

from SG HISTORY REPORT 
 historical event  

Not supported 

 
 

6.3.1 LIVE VIDEO FEED   

System Galaxy allows the operator to select live video from a single camera or multiple cameras at 
once. 

NOTES:  

 PAN / TILT / ZOOM controls are supported provided the DVR and camera are capable.   
 PRESET controls are supported provided DVR and camera supports preset 

programming. 
 Galaxy is Net Time Sync compliant as are the Discovery 3 & selected brand DVRs  

 

6.3.2 RECORDED VIDEO (  HISTORIC RETRIEVAL )   

NOTES:  

 Not supported in preliminary release of integration (10.2.0 ) 
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6.4 Getting Live Video  
There are several ways to get Video from System Galaxy. 

6.4.1 GET LIVE VIDEO FROM THE HARDWARE TREE 

The ‘View Live Video’ option is available on the short-menu when a [Door/Reader icon] or an [Input 
icon] is selected from the Hardware Tree in System Galaxy. 

1) Right-click on a [Reader Icon] or an [Input Icon] in the SG Hardware Tree that has been 
linked to a camera.   

 Elevator icons (red door icon) will behave the same as standard door icon.   

 You can also get video from a camera icon in the Hardware Tree. 

2) Select the ‘View Live Video’ option from the short-menu: This opens the GCS DVR Viewer 
and shows Live Video feed for the camera linked to the device. 

 

IMPORTANT: For trouble shooting tips see Chapter 5. 

 

 
FIGURE 17 – LIVE VIDEO FROM AN ICON ON HARDWARE TREE 
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6.4.2 GET LIVE VIDEO FROM THE DEVICE STATUS SCREEN 

 
The ‘View Live Video’ option is available on the short-menu from a Device Status item: 

1) Open the Device Status window by selecting View>Device Status from the SG main menu 
and select the desired ‘Status Group’ with the desired readers and inputs included (or add/edit a 
Status Group as needed).  Click [OK] to open the Device Status screen. 

2) Right-click a [Device Status icon/item] linked to a camera to get the short-menu. 

3) Select the ‘View Live Video’ option from the short-menu: This opens the GCS DVR Viewer 
and shows Live Video feed. 

 

IMPORTANT: For trouble shooting tips see Chapter 5. 

 

 

 
FIGURE 18 - LIVE VIDEO FROM A DEVICE STATUS  
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6.4.3 GET LIVE VIDEO FROM AN EVENT  

 
The ‘View Live Video’ option is available on the event item’s short-menu in the Loop Monitoring 
screen.  The Loop Monitoring screen and the Alarm Event screen are opened by default when 
System Galaxy is started running.  The screens show active logging of events and alarms 
depending on  

1) From the Event screen, right-click an Event which is linked to a camera to get the short-menu.   

2) Select the ‘View Live Video’ option from the short-menu: The DVR Viewer opens and shows 
Live Video feed.   

 

 

IMPORTANT: For trouble shooting tips see Chapter 5. 

 

 
FIGURE 19 - LIVE VIDEO FROM LOOP MONITOR EVENT SCREEN 
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6.4.4 GET LIVE VIDEO FROM AN ARMED ALARM EVENT  

Viewing live video is available from the Alarm screen.  There are several ways to see video from this 
screen. 

a) Automatic Call-up:  The GCS DVR Viewer automatically opens when an armed alarm comes 
in for a device that is linked to a camera (if the Automatic Call-up Video) is enabled in System 
Settings. 

 The GCS DVR Viewer shows live video feed for the priority alarm when the alarm 
device is in the “ARMED” condition.  Thus, if more than one device is in the alarm state, 
and priorities are used, the video comes from the device with highest priority 

 If a device becomes activated in the unarmed condition, the DVR Viewer will not 
automatically start up.   

 

b) Manual Call-up:  Operators can right-click an Alarm Event from the Alarm events List.  Select 
the ‘View Live Video’ option from the short-menu. 

 

 
FIGURE 20 – LIVE VIDEO FROM ALARM SCREEN WITH ALARMS  
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6.4.5 GET LIVE VIDEO FROM THE GRAPHICS SCREEN 

 
The ‘View Live Video’ option is available on the short-menu from the Graphics screen:  

1) From the SG menu, select View>Graphics and right-click a Door or Input icon of a device 
that has been linked to a camera to get the short-menu.   

2) Select the ‘View Live Video’ option from the short-menu: The GCS DVR Viewer opens and 
shows video feed with Real-Time clocking/time stamp.   

 
Remember that the clocks on the System Galaxy PC’s and the DVR unit should be synchronized to a 
common master clock source for accurate clocking/time stamping.   
 
 
FIGURE 21 - LIVE VIDEO FROM GRAPHICS SCREEN WITH DOOR AND INPUT ICONS        
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7 Appendix A: Camera Validation List 
Additional Camera Mapping Validation check list - Photocopy as needed. 
 

Table 1  System Galaxy Camera Mapping Validation check list 

DVR NAME:   

 

DVR LOCATION:   

Device Name/type 

(Front Door / reader ) 

Camera # 

( 1 ) 

Camera Name 

( Lobby Cam ) 

Location/Area Displayed  Check

(Front Door and Lobby Area)   Good 

   
1 

  

   
2 

  

   
3 

  

   
4 

  

   
5 

  

   
6 

  

   
7 

  

   
8 

  

   
9 

  

   
10 

  

   
11 

  

   
12 

  

   
13 

  

   
14 

  

   
15 

  

   
16 

  
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8 Appendix B: Ping the DVRs 
To ping a DVR Unit from the command prompt at the System Galaxy PC/Workstation do the following.  

Open a Command Window: 

1. Click [Start] button on the 
Windows® Task Bar 

2. Select the ‘Run’ option 

3. Type “cmd” in the field 
provided. 

4. Click [OK] button 

 
To ping: Once the Command Window opens, type the ping command with the target (DVR) IP 
Address.  See figure below.  Syntax is important, so type one space between command and IP 
Address.    
Type “ping nn.nnn.nnn.nnn”; where “n” stands for the numeric characters in the IP Address   
 

Example 1 shows a reply.  Example 2 shows that the target IP Address is not able to reply. 
 
Example 1 – Ping with Reply – good connection 

 
 
Example 2 – Example Ping with Request Time Out – failed to connect 
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